
 HSC 8 - Equilibrium Examples 
November 20, 2014 
 

 

Research Center, Pori / Petri Kobylin, Lena Furta, 
Danil Vilaev, Antti Roine 

14009-ORC-J 1 (52) 
 

 

Copyright © Outotec Oyj 2014 

14. Equilibrium – Step by Step Examples 
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14.1. Creating 2D Diagrams 
 
1. Start the Equilibrium Module. The starting screen is shown in Fig. 1. 
2. Open, Import or Create a file. 
 If you want to open an existing file (*.gem8) you should press Open or select Open in 

the File menu. You can also work with files in *.IGI and *.GEM formats by selecting 
Import in the File menu. It is also possible to create a new file by selecting Create 
Empty File or Empty File From Elements. 

a) Select Empty File From Elements, see Fig. 1. 
b) Select H, Ca, C and O from the elements. 
c) Select the form of species in which you are interested from the Search mode, in 

this example select Gases, Gas ions and Aqueous ions, see Fig. 2. 
d) Press Next and you will see the species found, see Fig. 3. 
e) Select species (using Ctrl and the left mouse button) as in Fig. 3 and press 

Delete Unselected. 
f) Select Gas, Aqua, Pure in the Sort menu see Fig. 3 (Choose yes when Pure 

substances at last phase is requested). 
g) Press Finish. 

3. Edit system parameters as in Fig. 4. 
4. Edit file or change options on the Parameters panel if necessary, see Fig. 5. 

a) Select T, P, N in the User Defined Parameters menu. 
b) Select 1 in Number of independent variables (2D diagram). 
c) Check Temperature. 
d) Specify the temperature range (from 25 to 225 °C), and give the Number of 

Steps required (default value is 21), see Fig. 5. 
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Fig. 1. Starting screen. 
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Fig. 2. Specifying the elements of the system H - O - C - Ca. 

 
Fig. 3. Selecting system species from the list. 
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Fig. 4. Created species input file. 
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Fig. 5. Specifying calculation parameters. 

5. Press Calculate (and OK on the warnings page) and Equilibrium will be calculated for 
the defined parameters. 

6. Press Show Chart on the Parameters panel or select Show Chart in the View menu 
and the Axis menu will be shown, see Fig. 6. 

7. Select one of the types for each axis – Temperature for X-Axis, Equilibrium Amount 
for Y-Axis. 

8. Select kmol unit for the Y-Axis. 
9. Press Finish, then the diagram will be drawn, see Fig. 7. 
10. You can format the appearance of the table or save the results. For more details, 

please see Chapter 13. 
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Fig. 6. Select data for axes. 

 
Fig. 7. 2D diagram. 
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14.2. Creating 3D Diagrams 
 
Repeat steps 1 – 10 from “Working with 2D diagrams”, except: 
 
3. Add step 0.15 to CO2(g). 
4. a) Select 2 in the Number of independent variables (3D diagram). 
4. b) Check Temperature and Amount. 
4. c) Set the number of steps to 21 in Amount. 
7. Select one of the types for each axis – Amount for X-Axis with Select Species, see 

Fig. 9, Equilibrium Amount (kmol) for Y-Axis, Temperature for Z-Axis (°C). 
 

 
Fig. 8. Select data for axes. 

 
Fig. 9. Select Species. 

When you press Finish, the 3D diagram will be drawn, see Fig. 10. 
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Fig. 10. 3D diagram. 
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14.3. Drawing on the Diagram Using the Toolbar 
 
You can add different objects or write some labels on the diagram, which can be very 
helpful in some cases. 
 
1. Create diagram. 
2. Select Toolbar in the Show menu in the Diagram window. 
3. Select one of the shapes (line, arrow, rectangle or circle) or label, see Fig. 11. 
4. Draw the shape using the mouse cursor. 
5. You can format the shape by selecting an inner color or border color, line width, line 

type. You can make the figure transparent, move it back or to the front, see Fig. 11. 
6. If you do not like it, you can delete any shapes. 
 

 
Fig. 11. Toolbar. 

 
Fig. 12. 3D diagram with shapes. 
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14.4. Drawing on the Diagram Using Object Editor 
 
There is one more way to modify diagrams by specifying the coordinates, sizes and colors 
of an object in Object Editor. 
 
1. Create diagram. 
2. Select Object Editor in the Show menu in the Diagram window. 
3. In the Insert menu, select one of the shapes (line, arrow, rectangle, circle) on the 

Shapes sheet or label on the Labels sheet, see Fig. 13. 
4. Specify all shape parameters (coordinates, border color, border width, etc.), see Fig. 

13. 
5. You can change these parameters later. 
6. If you do not like it, you can delete any shape in the Delete menu or via the button on 

the toolbar. 
 

 
Fig. 13. Object Editor of the objects in Fig. 12. 
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14.5. Transitory Evaporation and Open Atmosphere Modes 
 
The system consists of H2O, N2 (g), O2 (g), CO2 (g) and CO2 (a). Initially, only H2O, N2 (g), 
O2 (g) and CO2 (g) are present in the system, and gases are added to the system in each 
step (see Fig. 14). 
 
Transitory Evaporation (Remove Step %) 
 
1. Create file as in Fig. 14. 
2. Select the T, P, N system and 1 in the Number of independent variables. 
3. Check Amount in the Define state change for menu. 
4. Check Remove Step % Column ON 
5. Specify GAS phase Remove step % (100 in cell F4), see Fig. 14. 
6. Press Calculate and Show Chart when program has calculated the equilibrium. 
7. Select Step as X-Axis. 
8. Press Finish. 
9. Select only CO2(a) in the legend in the Diagram window and check AutoScale 

option, see Fig. 15. 
 
Open Atmosphere,(Infinite Gas) 
 
1. Create file as in Fig. 16. 
2. Select T, P, N system and 1 in Number of independent variables. 
3. Check Temperature in the Define state change for menu. 
4. Check Infinite Gas mode, see Fig. 16. 
5. Select Gas phase (P #1). 
6. Press Calculate and Show Chart and the program will calculate the system. 
7. Select Temperature as the parameter for X-Axis. 
8. Press Finish. 
9. Select only CO2(a) in the legend in the Diagram window and check the AutoScale 

option, see Fig. 17. 
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Fig. 14. Parameters for Transitory Evaporation mode. 

 
Fig. 15. Diagram for Transitory Evaporation mode. 
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Fig. 16. Parameters for Open Atmosphere mode. 

 
Fig. 17. Diagram for Open Atmosphere mode. 
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14.6. Fixed Activity Mode 
 
You can also calculate the system from the previous example in the Fixed Activity mode 
with a coefficient of 0.0003 (equal to mole fraction or vapor pressure of CO2(g) since an 
ideal gas is assumed) for CO2 (g), see Fig. 18. 
 
1. Create new file as in Fig. 18. 
2. Check Fixed Activity on the Parameters panel. 
3. Enter 0.0003 in the Fixed Activity column (H7) in the table for CO2(g). 
4. Press Calculate. 
5. Press Show Chart and the program will calculate the system.  
6. Select Temperature as the parameter for X-Axis. 
7. Press Finish. 
8. Select only CO2(a) in the legend in the Diagram window and check AutoScale 

option, see Fig. 19. 
9. Press Back in the Diagram window. 
10. Select Activity as the parameter for the Y-Axis. 
11. Select only CO2(g) in legend on Diagram window and check the AutoScale option, 

see Fig. 20. 
 

 
Fig. 18. Parameters for Fixed Activity mode. 
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Fig. 19. Diagram with Fixed Activity. 

 
Fig. 20. Fixed activity of CO2(g). 

You will then see a diagram as in the Open Atmosphere mode, see Fig. 19, and you can 
check that Activity for CO2(g) is constant as specified in the Fixed Activity coefficient, see 
Fig. 20. 
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14.7. Target Calculation 
 
If you want to find out the equilibrium condition where the amount of H2O is 1 mole, enable 
Target Calculations and set the parameters as in Fig. 21 (you can open the 
FESO4_target.gem8 file). 
 

 
Fig. 21. Parameters for Target Calculation. 

1. Open the FESO4_target.gem8 file 
2. Check Enabled in the Target Calculation menu on the Parameters panel. 
3. Select Species mole amount in Equilibrium Property. 
4. Select H2O in Target. 
5. Specify 1 in Target Amount. 
6. Press Calculate and view the results, see Fig. 22. 
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Fig. 22. Results of the Target Calculation. 
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14.8. HSC Equilibrium Module Examples 
 

 
Fig. 23. Specification of the chemical system. i.e. specification of phases, species, and raw materials 
(left side) and specification of the calculation type: Increase Amount, Temperature, or Pressure (right 
side). 
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Case 1: Hydration of Magnesia Chrome Bricks (ANKROM01.gem8) 
 
Magnesia chrome bricks are widely used as a lining material in pyrometallurgical 
applications because of their stability in process conditions. However, at room temperatures 
they easily react with moisture and crumble due to hydration reactions. HSC software can 
be used to estimate the lowest temperature that must be exceeded to prevent such 
reactions and to specify these reactions. 
 
Magnesia chrome bricks contain magnesium, chromium, iron, and oxygen. All species 
which contain these elements and hydrogen can easily be collected in the Equilibrium 
module from the database. The following ideas were used to specify the system (see Fig. 
25): 
 
- Metallic substances were removed, as they are not needed in these conditions. 
- Gas species (16) were inserted into the gas phase. 
- Other species (25) were assumed to exist as pure substances (invariant phases), 

because of the low temperatures where molten mixtures do not exist. 
- MgO, Cr2O3 and Fe2O3 raw materials were added according to their amount in the 

brick: MgO 60, Cr2O3 18 and Fe2O3 14 kg. 
- Water gas was added to the gas phase. The amount was set slightly higher than 

needed to hydrate all the species in the brick. 
- A small amount of nitrogen was added to the gas phase. 
 
The results of the calculations are shown in Fig. 24. This diagram shows that hydration of 
the bricks is possible if the temperature of the lining is lower than 270 °C. Hydration 
damage is caused only due to the formation of magnesium hydroxide; the chromium and 
iron do not take part in hydration reactions. Magnesium oxide (periclase) forms the matrix of 
the brick, therefore hydration of magnesium oxide crumbles the whole construction. 
 

 
Fig. 24. Calculation results for hydration of magnesia chrome brick. 
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Fig. 25. Specification of phases and species in the Magnesia Chrome brick example. 
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Case 2: Ammonia Synthesis (by Panu Talonen; AMMONIA.gem8) 
 
Ammonia was expensive to produce before the invention of the current process, which uses 
high pressure and iron catalyst. The synthesis is usually made at a temperature of 370 – 
540 °C. The effect of pressure on ammonia formation can easily be evaluated with the HSC 
Equilibrium module. The formation reaction can be written as follows: 
 

N2(g) + 3 H2(g) -> 2NH3(g) 
 
The number of gas moles decreases in this reaction and therefore high pressure may be 
assumed to favor the synthesis. The equilibrium calculation can be carried out as described 
in Chapter 13. The chemical system specification and other calculation parameters are 
shown in Fig. 27. The calculations are carried out by increasing the pressure from 0.001 to 
1000 bar at a constant temperature of 480 °C. 
 
The calculated results are shown in Fig. 26. It is easy to see that at normal pressure of 1 
bar it is impossible to produce high amounts of ammonia. It also seems that synthesis 
should be made at the highest possible pressure. However, modern ammonia plants 
operate at about 150 bar pressure for economic reasons. The ammonia is condensed from 
the gas mixture and the unreacted hydrogen and nitrogen are recycled back to the reactor. 
 

 
Fig. 26. Calculation results for the ammonia synthesis example. 
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Fig. 27. Specification of phases and species in the ammonia synthesis example. 
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Case 3: Decomposition of MgCl2*6H2O (MGCL2.gem8) 
 
All compounds will decompose if the temperature is high enough. Especially substances 
with crystalline water will decompose at quite low temperatures. The decomposition 
temperatures can be found in many different handbooks, but they may also be calculated 
with the HSC Equilibrium module if the basic data is available on the HSC database. 
Magnesium chloride forms a MgCl2*6H2O compound, which decomposes according to the 
reactions: 
 

MgCl2*6H2O -> MgCl2*4H2O + 2H2O(g) 
MgCl2*4H2O -> MgCl2*2H2O + 2H2O(g), etc. 

 
The decomposition temperature as well as the decomposition vapor pressure may be 
calculated using the chemical system specification shown in Fig. 28. The user must specify 
all possible condensed phases as well as a gas phase. Please note: A) A small amount of 
nitrogen will stabilize the gas phase, B) small amounts of Cl2(g) and O2(g) shift the material 
balance out from the stoichiometric one and C) Mg(g) allows magnesium to enter the gas 
phase also. 
 
The results of the calculations are shown in Fig. 29 and Fig. 30. The decomposition seems 
to start at 100 °C, see Fig. 29. The vapor composition is drawn in Fig. 30 by selecting the 
Equilibrium Composition option. This diagram shows that the vapor pressure of water is 
0.67 bar at 175 °C and 1 bar total pressure. To calculate vapor pressure at higher 
temperatures, the total pressure must be increased, for example, to 10 bar. 
 

 
Fig. 28. Specification of phases and species in the MgCl2*6H2O example. 
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Fig. 29. Vapour composition at a total pressure of 1 bar. 

 
Fig. 30. Equilibrium calculation results for the MgCl2*6H2O decomposition example. 
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Case 4: Decomposition of FeSO4*7H2O (by Ben Karlemo; FESO4.gem8) 
 
The thermal decomposition of a chemical compound will sometimes give valuable 
information of its behavior in a real chemical process. This evaluation may be carried out 
with the HSC Equilibrium module and with a thermo-gravimetric analyzer. These 
evaluations have been made in this example for FeSO4*7H2O. The chemical system 
specifications for the HSC equilibrium module are shown in Fig. 31. Please note (see 
Chapter 13 (13.4.): A) A small amount of nitrogen stabilizes the gas phase, B) a small 
amount 1E-5 kmol of O2(g) shifts the material balance away from the stoichiometric one, C) 
Fe(g) allows iron to enter the gas phase also. The results are shown in Fig. 32. 
 
The hydrates gradually decompose at 50 to 200 °C and sulfates at 400 to 650 °C. Hematite 
will reduce to magnetite at 1250 °C. These results may be used to explain the experimental 
thermo-gravimetric results shown in Fig. 33. The TG curve shows the actual weight change 
and the DSC curve shows the enthalpy change compared to the reference test. 
 

 
Fig. 31. The specification of phases and species for the equilibrium calculations. 
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Fig. 32. The result of the calculated decomposition of FeSO4*7H2O. 

The theoretical and experimental weight change curves are compared in Fig. 34, which is 
calculated in MS Excel. Both curves are in quite good correlation with each other. The 
decomposition occurs at slightly higher temperatures in the experimental results than in the 
calculated ones, but this may be explained by some kinetic effects. The final weight of the 
sample was nearly the same in the experimental and theoretical results at high 
temperatures. The decomposition reactions may also be verified by comparing the 
analyzed and the calculated gas composition with each other. 
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Fig. 33. Results of FeSO4*7H2O run on a NETSCH TG-DSC analyzer under nitrogen atmosphere 
showing TG and DSC curves. Heating rate was 5 °C/min. 

 
Fig. 34. The comparison of the measured and calculated mass change of FeSO4*7H2O. 
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Case 5: Alkali Circulation in a Blast Furnace (by Riku Sarkkinen; ALKAL1.gem8) 
 
Alkali metals tend to enrich in an iron blast furnace. The alkali content in raw materials 
(pellets, sinter and coke) is not so high, but they evaporate at the bottom of the furnace 
(~1500 °C) and do not exit with the products (slag, iron) easily. Nor do they exit with the 
process gas, which goes upward, because the temperature is quite low at the top of the 
furnace (~100 °C). This problem may be evaluated with the HSC Equilibrium module. 
 
The chemical system specification is shown in Fig. 36. The raw material amounts are 
based on the following assumptions: Coke ash analysis (main components): SiO2 53, CaO 
3, MgO 2, and Al2O3 27 wt %. Process gas is formed by air reaction with coke, and the 
main components in the gas phase are CO(g), CO2(g) and N2(g). The alkali elements are K 
and Na. The calculations are carried out as described in Chapter 13 by increasing the 
temperature from 500 to 2000 °C. Iron has not been taken into account because the alkali 
circulation occurs above the liquid iron zone. Equilibrium calculations were made as 
described in Chapter 13. 
 
The calculation results are shown in Fig. 35. At high temperatures almost all the sodium 
and most of the potassium seems to be in elemental form in the gas phase. These gas 
species flow with the main process gases upward where the cold charge materials 
decrease the temperature and alkalis react with the slag components. The reaction 
products are mainly sodium and potassium carbonates, sodium silicates, and potassium 
alumina silicates. These solid compounds flow downward with the blast furnace charge 
materials to the high temperature zone at the bottom of the furnace, where the alkali 
components vaporize again, which leads to the alkali circulation. 
 

 
Fig. 35. Equilibrium results of alkalis and slag components as a function of temperature. 
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Fig. 36. Specification of phases and species in the Blast Furnace example. 
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Case 6: Ga-As System (by Petri Kobylin; Ga-As_example.gem8) 
 
The theory of the solution models is given in Chapter 13 (section 13.10). The following step-
by-step example explaines how to use such models. 
 
This example shows how a solution model can be used and results are then compared to 
an ideal solution at 1000 K. The solution model parameters used in this example are not 
assessed properly, so the calculated phase boundaries differ from those found in the Ga-As 
phase diagrams in the literature. 
 
Step 1. Insert the phases and species: 
 
LIQUID phase  
Ga(l) 
As(l) 
 
SOLID phase 
GaAs 
 
Step 2. Give the input amounts and add a step, see Fig. 37 and Fig. 38. 
 
Step 3. Give 101 as the number of amount steps 1000 K (726.85 °C) as the temperature 
and 1 bar as the pressure. Units can be changed from the Units menu. 
 
Step 4. Activate the solution model. First, choose the phase from the input sheet where you 
want to use a solution model (here LIQUID is chosen), then select a Ga-As mixture from the 
solution model list and give the number of iteration rounds (120 rounds here) to calculate 
the activity coefficients (AC steps). If the solution model is left blank, an ideal solution is 
calculated, see Fig. 38. 
 
User can also open the file C:\HSC8\Gibbs\Ga-As_example.gem8 if he/she does not want 
to do steps 1-4. 
 
Step 5. Press calculate and Show Chart. Then choose the Amount (X-axis) and Equilibrium 
amount (Y-axis) and Finish. Fig. 39 shows the solution model results and Fig. 40 the 
results for the ideal solution. It takes some time to calculate the results using the solution 
model since many iteration rounds are used. Fig. 41 and Fig. 42 show the results of using 
only 10 iteration rounds, which is not quite enough since the lines bend on the Arsenic-rich 
side of Fig. 41 and the values of activity coefficients in the two phase region in Fig. 42 are 
not constant. 
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Fig. 37. Ga-As system parameters LIQUID phase solution model active. 

 
Fig. 38. Ga-As system parameters LIQUID phase solution model inactive (ideal solution). 
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Fig. 39. Results of Ga-As system with solution model at 1000 K, 120 iterations. 

 
Fig. 40. Results of ideal Ga-As system at 1000 K. 
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Fig. 41. Results of Ga-As system with solution model at 1000 K, 10 iterations. 

 
Fig. 42. Activity coefficient of Ga-As system with solution model at 1000 K, 10 iterations. 
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Case 7: As-Cu-S Transitory Evaporation Example (by Petri Kobylin; As-Cu-S.gem8) 
 
In this example, the results of a transitory evaporation calculation are compared to a normal 
equilibrium calculation. 
 
Step 1. Insert the phases and species, see Fig. 37. 
 
Step 2. Give the input amounts, put 9 as the activity of As and add a step, see Fig. 43. 
 
Step 3. Give 101 as the number of amount steps, 1200 °C (1473.15 K) as the temperature, 
and 1 bar as the pressure. The units can be changed from the Units menu. 
 
Step 4. Choose the Gas and Activate Remove Step % Column in the Calculation options. 
Add 20 % to the GAS phase (cell F4), see Fig. 43. 
 
User can also open the file C:\HSC8\Gibbs\ As-Cu-S.gem8 if he/she does not want to do 
steps 1-4. 
 
Step 5. Press Calculate, Click OK to note that As is extrapolated and press Show Chart. 
Then choose Amount Added (Raw materials) as the X-axis and Equilibrium amount as the 
Y-axis and press Finish. Filter the results to show only As compounds, see Fig. 44. The 
results look different when Remove Step is not used (i.e. can be unchecked from the 
Calculation options, see Fig. 45 and Fig. 46. 
 

 
Fig. 43. As-Cu-S system with parameters, gas removal of 20 %. 



 HSC 8 - Equilibrium Examples 
November 20, 2014 
 

 

Research Center, Pori / Petri Kobylin, Lena Furta, 
Danil Vilaev, Antti Roine 

14009-ORC-J 36 (52) 

 

Copyright © Outotec Oyj 2014 

 
Fig. 44. Results of As-Cu-S system with 20 % removal of the gas phase at 1200 °C. 

 
Fig. 45. As-Cu-S system with parameters, no gas removal. 



 HSC 8 - Equilibrium Examples 
November 20, 2014 
 

 

Research Center, Pori / Petri Kobylin, Lena Furta, 
Danil Vilaev, Antti Roine 

14009-ORC-J 37 (52) 

 

Copyright © Outotec Oyj 2014 

 
Fig. 46. Results of As-Cu-S system without gas removal at 1200 °C. 
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Seawater 
 
 
 
The HSC Chemistry 8.0 Equilibrium module can be used for many types of applications. 
This sample case demonstrates water solution calculations using the activity coefficients 
that have been calculated with the HSC Aqua module. 
 
In this example, the Equilibrium module will be used to estimate the effect of the global 
temperature on the equilibrium pressure of the carbon dioxide above the seawater. 
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Carbon Dioxide Cause or Effect? 
 

 
Fig. 47. Our climate has never been stable. Carbon dioxide may increase temperature or vice versa. 
Both are valid conclusions based on currently available experimental data. 

Mainstream science and the media believe that the main reason for climate change is the 
man-made carbon dioxide content increase in the atmosphere (AGW). The truth may, 
however, be the other way round. Ice cream consumption increases in warm weather in the 
summertime, but that does not mean ice cream is the cause of or reason for the warm 
weather. 
 
Several times within the past million years the seawater temperature has begun to rise 
BEFORE a similar growth in atmospheric carbon dioxide and methane concentrations. 
Recent analysis show that CO2 lags behind the warming and cooling of climate by 200 - 
800 years; this may be the time which is needed to reach steady state within the oceans 
and atmosphere. 
 
The latest evidence shows that the Earth's climate is constantly changing, as continuous 
change seems to be the normal state of nature, see Fig. 47. These changes have created 
and destroyed huge empires during the history of mankind. In fact, we should be talking 
about the temperature change of the oceans, because they control the climate - and there 
is 260 times more seawater than air on our planet, Fig. 48. 
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Fig. 48. There is some 260 times more seawater on the Earth than air. The amount of seawater is 
roughly 1.35E+21 kg. The amount of air is 5.15E+18 kg, which equals 3.99E+18 Nm3. The heat 
capacity of the oceans is 1000 times more than the heat capacity of the atmosphere. 
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Carbon Balance of the Earth 
 

 
Fig. 49. Carbon balance and storage. 

In practice, limestone is the "final destination" of carbon. Organic carbon returns back to the 
atmosphere due to respiration and fires. Bacteria and fungi decompose and oxidize organic 
material back into methane and CO2. In this respect, plants are only temporal carbon sinks. 
 
Manmade emissions are quite small compared to the natural carbon cycles. Oceans are the 
main carbon sink; they have harvested huge amounts of carbon into limestone over millions 
of years. In fact, biofuels also increase emissions, but it is still better to burn organic waste 
materials and utilize their energy content rather than letting them form methane in landfills 
or dumps. 
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The carbon dioxide emissions of oceans increase along with the surface temperature of the 
oceans. This is a fact which has been verified experimentally and can also be verified by 
chemical equilibrium calculations. Hot areas of oceans emit and cold areas absorb carbon 
dioxide. 
 
There are three key questions in the climate change discussion: 
 
1) The carbon dioxide content has increased rapidly many times in history and every 

time this increase has reversed and become a decrease, see Fig. 47. If the carbon 
dioxide really is the main cause of the climate temperature increase then why has this 
effect not auto catalytically increased the temperature and evaporated oceans? 
Which effect has stopped the temperature increase in spite of the high carbon dioxide 
content? 

2) Why has the temperature usually started to increase first and then after a few 
hundred years the carbon dioxide content has started to rise? The same delay seems 
to exist also when the temperature starts to decrease. In a normal industrial process, 
the cause always happens first and just before the effect and response. Why is this 
not true for the climate? 

3) Why has the Climatic Research Unit (CRU) heavily underestimated the effect of cities 
on global temperature data? Why has it even modified the raw data in order to obtain 
the temperature rise, and why has the original data been deleted? 

 
We can try to find an answer to these questions using chemical equilibrium calculations. 
 
Chemical Equilibrium Calculations 
 
One important question in the climate change discussion is the effect that carbon dioxide 
has on the temperature. A lot of different models with a huge number of fitting and tuning 
parameters have been created to estimate the effect of CO2 on the global temperature. 
These parameters have been needed to make the models agree with the global 
temperature data made by the CRU. 
 
However, far fewer calculations have been made to estimate the effect of temperature on 
the equilibrium pressure of the CO2 over seawater. This effect may be estimated using the 
HSC Equilibrium module, Fig. 50. This module does not use any tuning parameters; all the 
results are based on the basic thermochemical properties of the chemical species. These 
calculations are based on the chemical equilibria of theoretical aqueous solution models. 
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Fig. 50. Air - seawater - limestone chemical system specification in the HSC Equilibrium module. All 
the amounts have been divided by 1E+18 just to make the figures more readable. NB! This does not 
have any effect on the results. 
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Fig. 51. Effect of temperature on the activity coefficients in seawater. 

We can put all the oceans, atmosphere, and lot of calcite into a single chemical reaction 
unit and run equilibrium calculations. This chemical system specification is shown in Fig. 
50. The amounts and compositions of gas and water phases correspond to the average 
amounts and composition of the atmosphere and seawater. Calcite has been assumed to 
consist mainly of CaCO3. 
 
The equilibrium calculations can be carried out for different temperatures and CO2 amounts 
in the air. The Equilibrium module calculation routine uses the Gibbs Energy Minimization 
method, which determines the phase amount, and the composition combination where the 
Gibbs free energy of the chemical system reaches its minimum. This method automatically 
takes into account all the possible chemical reactions that may occur in this system. 
 
The enthalpy, entropy, and heat capacity data for the pure chemical compounds shown in 
Fig. 50 are based on the extensive HSC 8 thermochemical database. The non-ideal 
behavior of the water solution is calculated using the HSC Aqua module, Fig. 51, which 
uses an extensive aqueous solution database. The amounts and compositions of the air 
and seawater are based on average values available in public encyclopedias and Internet 
sources. 
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Results 
 
The current average CO2 content of the atmosphere is some 383 ppm. The average 
temperature at sea level is 15 °C. The equilibrium pressure of CO2 above the seawater in 
these conditions is only 157 ppm. This is the thermochemical explanation of why the 
oceans are the most important carbon sinks, see Fig. 49 and Fig. 52. 
 
The chemical potential and activity of carbon dioxide is lower in cold seawater than in air, 
and this is the chemical explanation of why carbon enters the sea in cold areas. If the 
chemical potential of carbon dioxide were higher in seawater, then seawater would release 
much more carbon dioxide into the air in hot areas, however, luckily this is not the case. 
 
On the other hand, at high surface temperatures, like 25 - 35 °C, the oceans may release 
carbon dioxide because the equilibrium pressure increases rapidly along with the 
temperature, see Fig. 52 and Fig. 53. The sun may easily warm up a thin surface layer of 
the sea and this is enough to increase CO2 emissions. At medium surface temperatures, 
this layer may behave as a barrier which prevents CO2 dissolution in seawater. 
 
Fig. 52 and Fig. 53 also show why the CO2 content in the atmosphere within the last 800 
000 years has never been lower than 160 ppm, Fig. 47. 
 
The carbon dioxide pressure and chemical potential difference decrease along with an 
increase in temperature. This simply means that the driving force for carbon dioxide 
absorption and accumulation in the sea is decreasing radically, Fig. 52. This always 
happens if the temperature of the oceans increases for any reason. Seawater emits CO2 
when the surface temperature of seawater is high, because carbon dioxide pressure is 
higher in seawater than in the atmosphere. 
 
The sea can easily absorb large amounts of carbon dioxide. Fig. 53 shows what happens if 
we change the amount of CO2 in the atmosphere. The result is that if we remove carbon 
dioxide from the atmosphere, then the sea will release CO2 until the CO2 content reaches 
140 ppm. On the other hand, if we double the CO2 amount in the atmosphere, then sea will 
absorb CO2 until the CO2 level in atmosphere reaches 180 ppm. Of course, in the long 
term, the conditions of the whole chemical system will change, but this calculation illustrates 
the direction of the chemical reactions. 
 
In fact, the total CO2 absorption potential of seawater is very high because the equilibrium 
partial pressure of CO2 decreases along with pressure, see Fig. 54, i.e. carbon dioxide 
dissolution into seawater increases along with pressure. This promotes formation of 
limestone, because seawater is generally supersaturated in calcite, CaCO3. The shells of 
marine organisms made of calcite can form limestone sediments, because calcite does not 
dissolve into seawater. Limestone is the most important destination for carbon, see Fig. 49. 
 
However, at very high pressure calcite also starts to dissolve into seawater; usually this 
happens about 4500 meters below sea level. This depth is called the carbonate 
compensation depth (CCD) or lysocline. Below this depth limestone sediments may 
dissolve. 
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Fig. 52. The effect of temperature on the carbon dioxide equilibrium pressure over seawater at 
steady state with homogenous phases. The average temperature is assumed to be 15 °C and the 
CO2 content in the atmosphere 383 ppm. The difference between the equilibrium curve and 383 ppm 
level creates the driving force of CO2 absorption. 

 
Fig. 53. Seawater may effectively buffer temporal CO2 variations in the atmosphere. The calculations 
have been carried out by changing the amount of CO2 in the atmosphere. 
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Fig. 54. Effect of sea depth on the partial pressures of carbon dioxide and water vapor. The CO2 
absorption potential of seawater increases rapidly when the total pressure increases. CO2 
dissolution into seawater increases along with pressure. However, at very high pressure calcite also 
starts to dissolve into seawater and this prevents the precipitation of limestone. Usually this happens 
when the depth is more than 4500 m. 

Most of the carbon in seawater is in deep areas, see Fig. 49. Theoretical chemical 
calculation results in Fig. 54 are in good agreement with this experimental fact. 
 
All these results are based on theoretical aqueous solution data. These thermochemical 
models could also be used inside climate models to calculate the dependence between the 
climate temperature and carbon dioxide content of the atmosphere. Then of course some 
calibration parameters should be used to fix these results more exactly with the 
experimental data. 
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Discussion 
 
Carbon dioxide dissolution into seawater increases when temperature decreases and 
pressure increases. See for example: http://www.geochem-model.org/publications/41-MC_98_131.pdf 
 
These results are in good agreement with the current calculations. 
 
The heat capacity of the oceans is 1000 times larger than the heat capacity of the 
atmosphere. Therefore we should monitor the temperature changes of the oceans because 
the oceans determine the climate of the Earth. 
 
The density of cold seawater is always less than that of warm seawater. This is why warm 
seawater will rise to the surface and cold sinks to the bottom. This also means that all the 
geothermal heat will rise to the surface from the seafloor, because warm seawater is 
always lighter than cold seawater. In lakes, the situation is of course different because the 
density of pure water is highest at a temperature of 4 °C. 
 

 
Fig. 55. Effect of temperature on seawater density. 

The primary reasons for global temperature changes are changes in solar activity and 
variations in the Earth's orbit, rotation and axis. See for example: 
 
http://www.gao.spb.ru/english/astrometr/abduss_nkj_2009.pdf  

http://myweb.wwu.edu/dbunny/research/global/geoev.pdf  

http://myweb.wwu.edu/dbunny/research/global/easterbrook_climate-cycle-evidence.pdf  
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Summary 
 
These very preliminary and brief chemical equilibrium calculations show that carbon dioxide 
may not be the only reason for the increase in the temperature of the Earth’s climate. In 
fact, it seems that a temperature increase may be the cause and the carbon dioxide content 
increase in the atmosphere the natural effect of the climate change processes. It is most 
likely that carbon dioxide contributes to global warming, but it is hardly the primary reason 
for global warming. 
 
These preliminary and simple equilibrium calculations prove that we should invest much 
more effort on atmosphere and ocean chemistry research. We have to improve the basic 
data of the equilibrium calculations and take into account also kinetics, temperature, 
pressure and concentration gradients, as well as validating the calculation models 
experimentally. 
 
We also have to remember that we must find sustainable, low cost, new energy sources 
and solve the extensive environmental and emission problems, because energy costs and 
recycling are the key issues if we want to improve worldwide welfare. This is a fact, whether 
climate change is due to human activity or not. 
 
The basic ideas of this paper may be summarized in the following conclusions: 
 
1) The oceans are and always have been the most important and pre-eminent carbon 

sinks, Fig. 49. 
2) The effect of humans is much less than 5% of the natural carbon cycle. 
3) Huge amounts of CO2 are released from the sea when the sun heats up the thin 

surface layer of seawater, Fig. 52. There are delays in this process due to diffusion 
and convection. 

4) In cold areas the oceans absorb huge amounts of CO2, see Fig. 52. There are delays 
in this process due to diffusion and convection. 

5) Deep oceans contain gigantic amounts of carbon, because carbon dissolution into 
seawater increases along with pressure, Fig. 54. 



 HSC 8 - Equilibrium Examples 
November 20, 2014 
 

 

Research Center, Pori / Petri Kobylin, Lena Furta, 
Danil Vilaev, Antti Roine 

14009-ORC-J 50 (52) 

 

Copyright © Outotec Oyj 2014 

Comparison to Experimental Data 
 

 
Fig. 56. Annual mean sea surface dissolved inorganic carbon. The cold red areas absorb much 
more carbon than the blue hot ones, i.e. the Arctic seas are CO2 absorbers. This experimental result 
is in good agreement with the current calculated results given in Fig. 52. 
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Fig. 57. Annual CO2 Flux Estimated from Air-Sea Difference in CO2 Partial Pressure. The red areas 
may emit and the blue ones absorb CO2. 
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Fig. 58. Partial pressure of CO2 may be very high at the sea surface at higher temperatures such as 
26 °C. In these conditions seawater cannot absorb CO2 at all. The average CO2 partial pressure in 
homogenous seawater is some 150 - 200 ppm, Fig. 52, but at the sea surface it may be much higher 
due to the slowness of diffusion and convection. 

In fact, the total CO2 absorption potential of seawater is very high because the equilibrium partial 
pressure of CO2 at deeper levels is very low, see Fig. 54. 

http://joannenova.com.au/global-warming/ice-core-graph/ 


